CS193J Handout #16
Winter, 2001-02

HW 2: JavaDraw
Due Midnight ending Tue Feb 19th

(Thanks to Julie Zelenski for creating this assignment.) Y our next assignment will be to construct a
simple drawing program that allows the user to draw shapesin various colors, cut and paste shapes,
and save and load drawingsto disk. In this handout, we will stick to discussing the functional
requirements of the assignment. Design hints and devel opment suggestions are given in a separate
handout. Be sure to thoroughly read both handouts so you understand both the functiona
specification and our design expectations. As aways, if you find something unclear, please ask! We
will have the usua extra office hoursin the days before the due date — see the course page.

This assignment will combine two of mgor OOP themes. using OOP GUI components and the
OOP inheritance problem of factoring severa related classes to make alittle hierarchy. For the
Swing part of the assignment, we have seen many of the relevant classesin lecture, but for some
classes, you will need to hunt through the Sun docs. The starting project gives you a good headstart
on the mundane aspects of setting up the user interface so you don't have to spend too much time
on these tedious aspects.

Overdl, thisassignment is more involved than your last one. Devel oping a good object-oriented
designisan incremental process that often takes severa iterations until you settle on aquality
solution. Don't handicap yourself by trying to throw the program together at the last minute!

JavaDraw basics

JavaDraw isasimple draw program. Initsfina form, it hasjust one window that contains a
drawing canvas and atool bar that supports the creation of rectangles, ovals, lines, and scribblesin
various colors. A selection tool allows the user to select, move and resize shapes. There are menu
commandsto cut, copy, and paste shapes, rearrange layering, and save and load shapes from files.
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What you start with

The above description and screenshot may seem daunting—however, don't panic, you won't have to
start from scratch. With graphical programs, even more so than with others, it is particularly
effective to learn by taking an existing program and extending it as ameans of gentle introduction
to acomplex set of classes. If you compile and run our starting program, you'll find that it can
already draw rectangles, select and deselect arectangle, and move or resize the selected rectangle.

Your job will beto first read our code to observe the basic usage of the GUI classes and then move
on to experimenting with additions, gaining confidence and deeper understanding as you go. Y ou
may begin with abit of a"monkey see, monkey do" approach but your skill growsinto amore
sophisticated mastery over the course of the assignment. Y ou avoid that frustrating initial struggle to
just get anything working and you have a good design in place to guide you. Since you start with a
working program, if you make small modifications as you go, you can continue to keep aworking
program each step aong the way, which will smplify the testing and debugging work.

In our starting project, there is a JavaDraw main class that constructs the user interface. It creates
the canvas window and its internals and installs the menus and their handlers. Thereisa Toolbar
class that configures the radio group of buttons with images for the tools and the current color
button that brings up the color chooser dialog. We aso give you a starting implementation of the
DrawingCanvas and Rectangle classes that handles simple rectangles.

What you need to do
The users want more and your mission isto start trying to satisfy their demanding requests! There
arefive features that you are going to add to the program:

1. New shapes. The most mgjor extension that you will be making isto support three new shapes.
The program as given only supports rectangles, you need to extend it to draw ovals, straight
lines, and "scribbles" (asquiggle of connected lines that trace a path).

2. Layering. Asshapesare created, they are added on top any previous shapes, overlapping and
covering up those shapes below. In our starting implementation, there is no way to re-arrange
the ordering after a shape has been created. The Layering menu contains unimplemented
"Bring to front" and " Send to back™ commands. These commands need to be implemented to
move the selected shape on top or beneath al other shapes.

3. Colors. The existing implementation assumes all shapes arefilled in dark gray. Y ou will extend
the program to create each new shape in the color currently selected on the toolbar. Y ou will
also update the tool bar to reflect the current color whenever ashapeis selected and alow the
user to change the color of the selected shape.

4. Edit operations. The Edit menu has unimplemented cut, copy, paste, and delete commands. Y ou
will implement operations to store a copy of a shape on the clipboard, paste the clipboard
contents, and delete shapes. The clipboard contents will be handled via object cloning.

5. Fileoperations. The File menu contains clear, load, and save commands that aso require your
implementation. The clear command just removes all shapes from the canvas. The save
command allows you to store adrawing to adisk file and the load command loads a previous
saved drawing. Thefile operations will be done using object seriaization.

(We ve covered the materia for 1-3 aready, so you can start with those. We'll be done with the
material for 5 and 6 in one more lecture, so you can wait on those.)

A little more detail

In general, the program is expected to behave in the common and obvious ways that basically all
drawing applications do (MacDraw, PowerPoint, Diagram, and so on). Probably all of you are
familiar with at least one of these applications and thus you will have an idea of what the godl is.
Y ou can also examine the behavior of our starting program to see how cregate, select, move, and



resize behave. The requirement summary at the end of this handout goes into painstaking detail
about the required behaviors that can help if you aren't sure of the nuances.

Hereisaquick summary of some of the basic behaviorsto get you started: The tool buttons alow
the user to select the current tool mode in effect. The tool mode determines what happens when the
user clicks and drags across the canvas. If the toolbar has a shape tool selected, clicking and
dragging on the canvas draws out a new instance of that shape. If the toolbar has the arrow tool
selected, mouse actions on the canvas will select, move, and resize shapes. Clicking on ashape
selectsit and a selected shape is drawn with resize knobs. Clicking and dragging on a shape moves
it. Clicking and dragging on aresize knob resizes the shape. All shapes arefilled, the color is set at
creation and can later be changed with the toolbar's color button. The layering commands move
shapes above or below others. Cut, copy, and paste alow you to store and retrieve duplicate copies
of ashape on the clipboard. The load and save commands alow you to save adrawing to disk and
reload it later. The assignment does not require support for advanced features like multiple shape
selection, undo, printing, framed shapes, multiple document windows, scrolling, and so on.

Input and output

Again, you will need to use abit of file I/O, yet we still haven't gotten to talking about exceptions
which are usually heavily in the stream classes. Aswe did for hw1, we will provide you with
wrapper classes to help smooth thisover. The Si npl eCbj ect Reader class can open afilefor
reading and has methods to read objects from it one by one and rehydrate them. It expectsthe
objectswere serialized to thefileusing aSi npl eCbj ect Wi t er. Thisclass opensafilefor
writing and can write serializable objectsto it. The provided source files are documented (in javadoc
format) with more details on the methods and usage for each class.

Requirements summary
Likewedid for HW2, asummary list we constructed to help you manage the details:

General

* Your source files should be easily readable on UNIX— i.e. end-of-line characters should be
proper, lines shouldn't wrap in obnoxious places, etc. Thisis of particular importance to those
of you moving your filesto Solaris from elsewhere.

* The submitted project should include all necessary source files and images. We should be
abletoissuethecommandj avac *.j ava and al files should compile cleanly (i.e. with no
warnings).

* Your main class should be named JavaDraw and should require no command-line arguments.
After compiling, we should be able to run your program with the command
j ava JavaDr aw.

* The program should run as a Java application, not an applet.

Selection tool

When the arrow tool isthe currently selected tool mode on the toolbar:

* A click causes the topmost shape under the mouse to become the currently selected shape.
Any previoudy selected shape is desglected. The currently selected shape is drawn with resize
knobs on its corners. Clicking on a shape that is aready selected makes no change.

» Clicking on the canvas but not directly on a shape deselects any previously selected shape,
leaving the selection empty.

» Clicking and dragging on a visible knob of the selected shape resizes the shape, alowing it to
shrink and grow. Resizing affects some shapes alittle differently (see descriptions below).

» Clicking on a shape (but not within aresize knob) and dragging causes the shape to move
with the mouse. The shape stays the same size but is trandated around the canvas.



» Thereisimmediate visual feedback when selecting or desel ecting a shape as well as continual
updates during moving and resizing.

Rectangles

» When the rectangle is the currently selected tool mode on the toolbar, clicking and dragging
on the canvas creates a new rectangle that resizes with the user'sdrag. The user can drag out
the new shape in any direction (i.e. not just down and to the right). The new rectangle appears
on top of any previous shapes and isfilled with the toolbar's currently selected color.

» Moving arectangle trand ates the coordinates of its bounding box in the obvious way.

* Resizing arectangle moves the selected knob to a new location while the opposite diagonal
knob remains "anchored” in place. A rectangle can be resized smaller or larger in either or
both dimensions.

Ovals

* When the oval toal isthe currently selected button on the toolbar, clicking and dragging on
the canvas creates a new oval that resizes with the user'sdrag. The new oval appears on top of
any previous shapes and is filled with the toolbar's currently selected color.

» Anova can bethought of as transcribed within arectangular bounding box. The behavior of
that bounding box is quite similar to the standard rectangle shape.

» Anoval hasfour resizing knobs, one on each corner of the bounding box.

* For aclick to select an oval, it must be within the ova'sfilled region. A click within the
bounding box but outside the filled area (i.e. in one of the corners) does not select the oval.

» Moving an oval trandates the coordinates in the obvious way.

* Resizing an oval moves the selected knob to a new location while the opposite diagonal knob
remains "anchored” in place. This changes the oval's bounding box, which changes the
dimensions of the oval. An oval can beresized smaller or larger in either or both dimensions.

Lines

* When thelinetool isthe currently selected button on the toolbar, clicking and dragging on the
canvas creates anew straight line that resizes with the user'sdrag. The new line appears on
top of any previous shapes and is drawn in the toolbar’ s currently selected color.

* A line can be thought of as adiagonal line across arectangular bounding box. The behavior
of that bounding box is quite similar to the standard rectangle shape.

* A line hastwo resizing knobs, one on each end of the line segment.

* For aclick to select aline, it must befairly closeto the line segment. A click within the
bounding box that is not near the line (i.e. in an opposite corner) does not select theline.

* Moving aline trand ates its coordinates in the obvious manner.

* Resizing aline moves the selected knob to anew location while the other knob remains
"anchored” in place. This changes the line's bounding box, which changes the length and
angle of theline. A line can be resized smaller or larger in either or both dimensions.

Scribbles

» When the scribble tool is the currently selected button on the toolbar, clicking and dragging
on the canvas traces out a path on the canvas following the mouse movement. The new
scribble appears on top of any previous shapes and is drawn in the toolbar's currently selected
color.

* A scribble can be thought of as a sequence of points connected by line segments. The
minimum and maximum coordinates along the path in both dimensions define the scribble's
rectangular bounding box.



* A scribble has two resizing knobs, one on each end of the scribble (i.e. the first and last points
on the path)

* For aclick to select ascribble, it must be reasonably close to a segment of the path. A click
within the bounding box that is not near a path segment does not select the scribble.

» Moving ascribble trandates its coordinates in the obvious manner.

* Resizing a scribble works differently than other shapes. Clicking and dragging one of the
resize knobs doesn't scale the entire scribble, but instead allows you to extend the path in that
direction with additional points. The end of the scribble path follows the mouse drag and
lengthens the path, potentially enlarging its bounding box. There is no way to shrink or
shorten a scribble path.

Layering

» The"Bring to Front" command moves the selected shape to the top so that it is drawn above
all other shapes and will be the first to receive mouse clicks. The ordering of al other shapes
remains the same. This command has no effect when there is no selected shape.

» The"Send to Back” command moves the selected shape to the bottom so that it is drawn
below al other shapes and will be the last to receive mouse clicks. The ordering of all other
shapes remains the same. This command has no effect when there is no selected shape.

Colors
» Whenever anew shape is selected, the color button on the toolbar updates to show the color
of the selected shape.

* Clicking on the color button brings up the color chooser dialog that allows the user to select a
new color. After the user chooses a color and dismisses the dialog, the currently selected
shape (if any) changesto the new color.

Edit operations

* The clipboard operations must be implemented by object cloning. Each shape must be capable
of cloning itself to store onto the clipboard. We are not interfacing with the system clipboard
which hasits own complications. Our “clipboard” is simply a copy of the most recently cut
or copied shape.

» The"Copy" command stores a copy of the selected shape onto the clipboard, replacing any
previous clipboard contents. There is no change to the shape or the canvas. The copy
command has no effect when thereis no selected shape.

» The"Cut" command copies the sel ected shape onto the clipboard and del etes the shape from
the canvas. After acut, there will be no selected shape. The cut command has no effect when
there is no selected shape.

» The"Paste" command adds the shape on the clipboard to the canvas. The newly pasted shape
becomes the selected shape. The pasted shape should be a duplicate of the last shape that was
cut or copied (e.g. same shape type, location, size, color). The same clipboard contents can
be pasted multiple times. It isanice touch (but not required) if a subsequent paste is offset
dightly from the previous so the identical shapes don’t pile on top of one another. The paste
command has no effect if the clipboard is empty (i.e. no cut or copy has been performed).

» The"Delete" command deletes the selected shape from the canvas. It does not change the
clipboard contents. After adelete, there will be no selected shape. This command has no effect
when there is no selected shape.

File operations
» The"Clear All" command deletes al shapes, returning to ablank canvas. There will be no
selected shape.



* Thefile operations must be implemented by object serialization. Each shape must be able to
read and write itself to a stream. We provide smple classes that wrap the object streams to
simplify the I/0O and handle exceptions for you.

» The"Load" command brings up afile chooser dialog that allows the user to select afileto
load. The program should open thefile, read the shapes, and replace the current contents of
the canvas with the shapes from the file. There should be no selected shape after a successful
load. If the file cannot be read or doesn't contain any valid shapes, the current contents of the
canvas are |eft unchanged.

» The"Save" command brings up afile chooser diaog that alows the user to select afilename
for saving. All of the shapesin the canvas should be saved to the file. The contents of the
canvas are not changed in any way. If the file cannot be written, no error is reported.

» The"Quit" command exits the program. It does not have any safety checksto ask the user to
save changes before quitting or any such niceties; it just immediately exits. Closing the
window also exits (The code for this case is aready in the starter file.)

A few random details

The starting project uses Swing components and thus will require an environment with Swing GUI
support — see the course tools page for help on running Swing on the various platform. Running a
Swing app on our leland Solaris machines sometimes may spew messages about missing fonts.
These are harmless and can be ignored. Depending on your window manager on leland, some
windows may show up with the dightly wrong appearance. Thisis an interaction bug between the
Swing implementation and the window manager, so it’s nothing to do with your code.

Grading

Functionality will be tested by verifying that your draw program can perform all the required
operations on all four types of shapes, redraw correctly as shapes are moved, resized, change color,
etc., can cut/copy/paste, load and savefiles, and so on. Design will be weighted somewhat more on
this assignment than the last, since that is where much of your effort will be going. Design will
consider how well you succeeded at constructing a sensible hierarchy, factoring the common data
and code, and designing objects that provide for good abstraction and encapsul ation.

Getting started
Asusua, there are starter files available off the course page. There' salot of basic stuff done for
you, so you' Il need to spend alittle time familiarizing yourself with the provided code.

No matter where you do your development work, when done, it is your responsibility to ensure
your project will compile and run properly on the leland workstations. All assignments will be
electronically submitted there and that is where we will compile and test your project. We
recommend moving your code over aday or two in advance to give yourself plenty of time to test
and resolve any problems instead of trying to deal with everything in alast-minute panic.



